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Direct to APRA - D2A

• D2A can be downloaded directly from the APRA website.
See http://www.apra.gov.au/CrossIndustry/Pages/Install-D2A.aspx

• Entities must have an AUSkey in order to use D2A. 
See http://www.apra.gov.au/CrossIndustry/Pages/AUSkey-FAQ.aspx

• Before using AUSkey with D2A, you must complete the 

AUSkey acknowledgement form and send it to APRA. 

• D2A is SBR compliant and any replacement system that APRA 

introduces in future will also be SBR compliant.

• Submit new data, retrieve previously submitted data, and 

amend and resubmit forms if required.

• Perform test submissions to ensure data meets validation 

rules, etc.



Data collection process - Overview

• D2A forms will be available 1 month prior to the period end 

date. 

• APRA sends a reminder email to all reporting entities 7 days 

prior to the due date.

• APRA will issue emails to all reporting entities who have not 

submitted their returns by the due date. 
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Data collection process – Overview 
(Contd.)

• D2A forms contain validations which must be passed for 

submission to occur.

• Post submission data queries will be emailed to entities 

where anomalies are found. Entities have 2 days to provide 

a response or resubmit the return. 

• Resubmissions of prior periods can be made at anytime. PHIs 

must notify APRA of any resubmission. 
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What is a taxonomy?

• A collection of data elements, similar to a dictionary 

that classifies and defines data and its uses.

• SBR taxonomy is written in XBRL (eXtensible Business 

Reporting Language).

• XBRL is an open data standard computer language that 

incorporates business meaning within the code such as:

� balance type (debit/credit).

� period type (instant/duration).

� data type (monetary, date, percent etc.).

� business labels. 

� definitions and guidance.
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SBR XBRL taxonomy structure
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Definitional Taxonomy
Harmonised taxonomy

elements from all agencies

Each agency has their own 

reporting taxonomies

The same element may 

be reused on multiple 

reporting taxonomies. 

(Each reporting taxonomy 

equates to a single form)
Reporting Taxonomies

SBR 
Taxonomy

ASIC

Form 1

Form 2

ATO

Form 1

Form 2

SROs

Form 1

Form 2

APRA

Form 1

Form 2



XBRL instance documents

• File containing facts represented in XBRL format.

• Each fact corresponds to a concept defined in XBRL 

taxonomy, i.e. a data item on a form.

• XBRL instance documents contain contexts and units 
declarations that provide additional information 
needed to interpret facts.

Contexts: entity ABN, applicable dates, applicable 
dimensions and dimension members

Units declaration: monetary - AUD

9



How the taxonomy may be used
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This is where you 

tag the data

These are 

instance 

documents 

containing data



Reporting taxonomy 
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Like a barcode XBRL is not designed to be human readable.

APRA’s solution = PET (Plain English Taxonomy) 



PET – Plain English Taxonomy
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How it fits together
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Introduction

Why use XBRL in D2A?

• The creation of an XBRL instance document against a 

reporting taxonomy is the recommended and supported 

method to import information into a D2A form. 

• The XBRL instance document is also automatically validated 

against the reporting taxonomy while importing into D2A. 

• For any replacement systems, XBRL is the supported method 

and therefore any development work you do now will be 

supported in the future.
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XBRL functions within D2A

• Must install Altova XML Spy available for download from 

APRA D2A XBRL Website http://www.apra.gov.au/CrossIndustry/Pages/D2A-

and-XBRL.aspx.

• Enable the SBR functionality in D2A.

• Refresh SBR to ensure the latest version of the SBR 

taxonomy is in the system.
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D2A test mode

The test mode provides a test ground for entities to test the 

content and structure of the SBR XBRL instance document 

without sending the data to APRA. 
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Test Mode of D2A

Once the test mode is activated, all the function buttons will 

be highlighted in yellow to show that it is in test mode. 
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Support for taxonomy 

development in D2A

• D2A and XBRL page 
http://www.apra.gov.au/CrossIndustry/Pages/

D2A-and-XBRL.aspx

• SBR Taxonomy Files

Contains the definitional and 

reporting taxonomies

• Association Files

These files map specific version of a form 

to a specific version of the taxonomy. 

Taxonomy and form versions change over 

time and it is important to ensure that 

they are in sync.

D2A Help Desk number (02) 9210 3400

Position for image
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D2A forms and returns
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Return Name

Return for a 

single period

Form in a 

return



D2A data submission process
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Requesting forms in D2A

• The first step in submitting data to APRA is to request the 

forms. 

• To request forms open D2A – from file menu –select New or 

click on the new icon.
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Requesting forms in D2A
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Opening forms in D2A

To open a return – select the relevant return and period – click 

New.
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Opening forms in D2A

This is what you will see.
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Entering D2A data

• Data can be entered into D2A using one of following ways:

�Direct Import of data.

�Copying and pasting / manual entry.

• Values entered in the form fields may be one of three 

types:

�Text.

�Numeric (non- monetary).

�Monetary.
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Importing data into D2A

There are two ways of how data can be imported into D2A:

• Data can be imported from saved forms or returns, into 

a new form or forms that already contain data.

• If SBR enabled, then data can be imported from an XBRL 

file.
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Importing data (contd.)

From the file menu, select Import  or click on the     import 

icon in the toolbar. 
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Importing data (Contd.)

When importing a return:

• If there are no conflicting values, the data is imported. 

• If there are conflicting values, then you will be prompted to 

select the values that are to be imported into D2A.
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Copying and pasting data

When copying and pasting data into D2A you should be aware 

of the following:

• Copying invalid characters into a form may corrupt the 

submitted file. 

• Invalid characters include any non-alpha numeric 

(special) characters, e.g. ? } ~ | etc.

• When copying and pasting data, you will need to ensure 

that the copied data is in line with the D2A form.

• When copy pasting text from Excel or Word, ensure that 

all formatting is removed, as this may result in data 

error. 
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Copying and pasting data (contd.)
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• D2A performs validation checks as data is entered into a 

form. 

• Errors are highlighted with a red box around the 

applicable field. 

• Data errors must be corrected before you can move to the 

next field or task.

Nursing Home Type Patients Episodes Days Benefits paid 

Public hospitals 0 0  $                              -   

Private hospitals 0 0  $                              -   

Total Nursing Home Type Patients 0 0  $                              -   
 



Adding rows to tables 

• If you require more rows in a table, than what is provided in 

D2A:

�Move the mouse to the required table.

�Right-click and select Add new row.

�A new row is added at the bottom of the table.

• You can also remove rows by right-clicking a table and 

selecting the applicable option.

• Additional rows are automatically added when the data is 

imported from XBRL and copy pasting from another file.
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Saving and printing 

Saving forms and returns:

• To save a form or return, either select Save from the File 
menu, or click the Save icon from the toolbar

Printing forms and returns:

• Forms and returns can be printed at any time.

• If an entire return is open, all forms within the return are 

printed, i.e. not just the form visible in the right hand pane.

• Open the form or return you want to print.

• From the File menu select Print, or click the Print    toolbar 
button.
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Refreshing validation rules

• From the Tools menu select Validation then Refresh Rules, 
or click the Refresh Rules       icon from the toolbar.

• When the refresh is complete, click OK.
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Validation of data 

D2A performs three types of checks. They are:

• Mandatory checks highlight any mathematical  logic errors 
or factual inconsistencies. Entities will not be able to submit 

the return with a mandatory error. 

• Confirmation checks highlight any reporting errors or data 
discrepancies that may require an explanation. Entities are 

required to either correct error or confirm that the variation 

is correct and provide an explanation.

• Cross form checks for discrepancies between expected 
values across two or more forms.
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Validation of data (contd.) 

• For confirmation explanations to be accepted by APRA, the 

explanation must be sufficient, accurate and complete and 

in particular, it must explain why the data is not an error. 

• APRA will not accept an entity’s explanation of data where 

the response does not contain any explanation of the data, 

or explanations that only comment on the value of the rule 

or check. 

• If an entity has a question about a rule or suggestion to 

improve it, the entity should contact APRA for clarification 

before the data is due to be submitted.
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Validation of data (contd.) 

To validate a return and complete all derived and calculated 

fields: 

• From the Validation menu select Validate, or click the 
Validate icon from the toolbar.

• If no errors, then the Validation Progress window indicates 

“There are no validation errors or warnings. Completed”.

• Click OK.
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Validation of data (contd.)

• If there are errors, the validation window displays the errors 

found. 

• Errors from individual forms are displayed on separate tabs.
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Submitting a return in D2A

• Only whole returns can be submitted to APRA. 

• Complete and validate all the forms within the return prior 

to submission. This reduces the number of potential errors 

messages during submission.  

• Once all validations are passed, the return can be submitted 

to APRA.

• From the File menu select Submit, or click the Submit 
icon on the toolbar.
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Submitting a return in D2A (contd.)

• Enter your security details and click OK.

• If no errors are detected during submission, the Information 

window is displayed containing your submission reference 

number.

• Keep a note of your reference number.

• Click Close.
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Resubmitting a return in D2A

• A return can be resubmitted at anytime if changes need to 

be made after the initial submission. 

• PHIs must notify APRA of any resubmission.

Resubmission process

�Notify APRA of resubmission.

�Access the previously submitted return to APRA. 

�Download relevant return for the relevant period. 

�Make changes as required. 

�Revalidated the return.

�Resubmit return to APRA.
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Accessing previously submitted 
return in D2A

To view and downland previous returns:

• From the Tools menu select Get Data, or click on         Get 
Data icon in the toolbar.

• Enter your security details and click OK.
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Accessing previously submitted 
return in D2A (contd.)
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• Select the return • Select the relevant period 

and click on download.



Accessing previously submitted 
return in D2A (contd.)

When the  download is complete, click ok. The selected return 

is now open. 
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Closing a return in D2A

To close a form or return, either select Close from the File 
menu, or click the Close toolbar       button.
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Support available

• APRA Statistics - statistics@apra.gov.au for help with 

validation rules and queries on reporting requirements.

• D2A Helpdesk – support@apra.gov.au for technical issues 

with D2A application.

• D2A section of APRA website -

http://www.apra.gov.au/CrossIndustry/Pages/D2A.aspx

• SBR - http://www.sbr.gov.au/

• XBRL - https://www.xbrl.org/
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